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Huntron Workstation Software Tutorial for Model 30

It is very helpful if you have a working knowledge of Microsoft Windows prior to using
Huntron Workstation.

You are allowed to create a backup copy of the software disk. Your purchase
agreement allows for copies to be made for backup purposes only- copying for

distribution or resale is strictly prohibited.

Installation Instructions

Refer to the Getting Started document included with the Tracker Model 30 for
complete instructions on software installation.

Uninstall any previous versions of Workstation prior to installing the new version.
Insert the Huntron Workstation CDROM. The CDROM should Autorun and begin the
installation process. If your PC has Autorun disabled then open a browse window to
the CD and select WorkstationSetup.exe. This will begin the installation process.
During the install you will be asked to install additional software for Access Probers.
Answer NO to these questions if you do not have an Access Prober.

If you purchased CAD Tools then install using the supplied CD. Follow instructions
listed in the CAD Tools Tutorial.

If you are using Workstation in conjunction with a digital multimeter, follow the
instructions listed in the Workstation DMM Tutorial.

All of the Workstation tutorials are available on the Huntron web site:

www.huntron.com/sales-support/software.htm
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Huntron Workstation Main Interface

When starting Huntron Workstation for the first time, you will be prompted for an
activation code. Type in the code exactly as it is presented on the installation CD.
Huntron Workstation 4 has built-in conversion utilities that enable conversion of board

tests created in 3.X versions of Huntron Workstation.
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The Main Window for Huntron Workstation 4 features a multi-pane layout so many
aspects of the test creation and execution can be displayed at the same time. The
Panes are interactive to a certain degree in that changes in one Pane will affect other
Panes. The Panes can be resized, floated independently or “tabbed” to the sides of the
window. The Status Bar displays information about items currently selected and status

information while processes are running.
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The Toolbar
The Toolbar just under the application menus allows for quick access to several

program functions. The function of each is broken out in the diagram below.

SASRSAARARAARNAAN

4, 5. 6. 7. 11.12.13. 14. 15. 16.17. 18.
1. Create New Board database 10. Repeat New (Sequence, Component)
2. Open Board database 11. Scan Component or Net
3. Save As... 12. Scan Sequence
4. Add New (Sequence, Component or Range) 13. Send Prober head to Home position
5. Copy (Sequence, Component, Net or Range) 14. Connect/Disconnect Prober
6. Paste (Sequence, Component, Net or Range) 15. Previous Component or Net
7. Cut (Sequence, Component, Net or Range) 16. Next Component or Net
8. Delete (Seq., Comp., Net, Range or Scan) 17. Previous Pin
9. Build New (Sequence, Component) 18. Next Pin

Hardware Setup

I Hardwalel Prober] Color I Scan l Signa!urel Sequencel Component I Net ] Pin I Rangel Test I

General Settings

Unit of Measure [Close File Ta Enable] Compare Depth Drain Time [milliseconds]
IM ils Y l Range 'I 50

Failed Text Minimum Short Resistance (Ohms)

FAILED I

Passed Test Maximum Short Resistance [Ohms)

IPASSED 10 [ CAD tab at Startup

[ Disable Maintenance Wamings

V' Load Previous Board at Startup

Board Path

| Browse...

OK [Temporary] LCancel Save [Permanent] Default Tab Values Help

When first starting Huntron Workstation, select Options from the Tools menu. The
Options window is used to setup default settings used when working in Huntron

Workstation.
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For this tutorial, the Tracker Model 30 will be referred to in general as “Tracker”. The

Scanner II and Scanner 31S will be referred to as “Scanners”.

General Hardware ]Proberl Color I Scan I Signature] Sequencel Component I Net I Pin ] Hangel Test I

Hardware Settings

Tracker Prober XY Correction Steps
ITracker 30 :] I None _'_I 3 v
Tracker Port Prober Serial Port XY Accuracy [Microns)
[use =l | |[come -] B | [i5
Scanner Frame Grabber XY Steps Per Second
IScanner ] l] ]None vl
=] 22
¥ Enzbl | Enab Z Steps Per Second
Scanners
- ™ NFSA Mounted = MFSA Mounted
Z Correction Steps
I™ Access (2) UGB Grey Camera I1 ']
Z Accuracy [Microns)
50
LConnect
OK (Temporary] LCancel Save [Permanent] Default Tab Values Help

Select Options from the Tools menu. Select the Hardware tab and set the type of
Tracker hardware that is connected to the PC, the Tracker Port (USB) and Scanner (if
connected; Scanner II users should also select the number of Scanners connected in
the “Scanners” drop menu). Disregard the Prober settings on the right side of the

window.

Click the Connect button to initiate communication with the selected hardware. Once
connected, click the Save (Permanent) button to save this configuration as the

startup default.

Using a Tracker Model 30

The Tracker Model 30 comes from the Factory calibrated for standalone use. If the
Tracker Model 30 is connected to a Prober, Scanner or other cabling, calibration must
be performed.

- Select Tools/Maintenance/Tracker Model 30 Diagnostics from the menu.

Click the Calibrate button the Tracker Model 30 Diagnostics window. When the
Calibrate procedure finishes (about 10 minutes), run Verify Calibration. This also takes

about 10 minutes to complete. The Calibration information is stored in the Tracker

© Huntron, Inc 2014 21-2260 Rev C 5



Model 30 and will be used by the software. If changes are made to the cabling or

attached instruments, simply run Calibrate and Verify Calibration again.

Manual Modes - Tracker and Scanner

Signature — Tracker: Tracker 30 Scanner: : None
[ Signatues | Scan [ Tioublesheet] Tracke: Scannet | Feview |
R Channel A
oz = Channel A
Resistance T
[io =] T
Frequency
2200 ¥
Ch. A x| T A
Tol 5 ~| I Realtime —_—tt 4 w1 4
Switch |Res ¥ I Fiter Scan ’—
Hold From R
— — SeanHold | [~ siop on D
Clear Set Range
n Siop From Comp N
0.2 10 200 Dev: 0 Area: 0 0.2 10 200

You may find it useful to manually test some of your components while adjusting the
range parameters. The two manual modes, Tracker and Scanner located in the
Signatures pane, can work together to display the signature of a component pin.
Tracker mode sets the range parameters, channel and tolerance. Signatures will be
displayed to the right while probing with hand-held probes (select the Real-time check
box). The Hold button will capture and hold the current signature allowing for quick
comparisons. The Clear button will clear the “held” signature.

Scanner mode allows you to use a Huntron Scanner to interface to the component
pins. You can set the package type, number of pins and common pins. The Scan
button starts a hands free scan of the component through the scanner cable interface
or you manually increment the pins with the << and >> buttons. The Hold button will
capture and hold the current signature allowing for quick comparisons. Manual modes
are for real time display only and does not allow for permanent signature storage. To

store signatures you will need to create a Board Test.
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Creating a Board Test

There are a number of steps necessary to creating a board test.

Huntron Workstation Test Layout (Tree)

Board (creates an Access .mdb file)

|

Sequence (test set of components)

|

Component or NET (name; e.g. U1, CR7, AO, +5V)

|

Pins (name, channel, etc.)

|

Ranges (range settings; voltage, resistance, frequency)

Example of Board Test Information:
Board Name: Main Board (creates “main board.mdb” file)
Revision: Rev. A (This field is optional)
Sequence: IC's
Component: U27 (component name) or A2 (NET name)
Pins: per pin settings for Scan Pin setting, channel, net name, etc...
Ranges: Per pin settings for common reference pin, tolerance, etc...
The user has total discretion as to the information input into these fields. There is no
“right” way as to what information is entered as every user’s situation will be different.
The above example is just one way the information might be entered.
Entering information into the Entry windows is very straight forward. The easiest way
to move from field to field is by pressing the TAB key. You can also use the mouse to

click into a particular field so you can enter information.
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Test Building Procedures
- Create Test Database in the Tree Pane
o Add Board, Sequence, and Components before teaching or scanning

- Scan Components and Set References (Tracker only or Tracker/Scanner users)

Listed above is a general outline on how you would proceed when preparing to test a
board. These guidelines apply to all package types and boards. As with any type of
complex test equipment, practice makes perfect so take the time to learn and practice

these procedures.

Creating a Board Database

M arne ; bl anufacturer I
R evizion I Gold Dizk Mumber I
System I nit of Measure IMils j
LI it I Drata Source IUEEf
Top Mame IT ap Baottarn M ane IEh:ttn:nm
— Instructions
Load CC File. . (1] LCancel Buttons... Help

To create a new Board, select New from the File menu or use the New button in the
toolbar. Input information into the “"Add New Board” dialog as needed. The only field
that is required is board Name. Other fields such as Revision, System, Unit,
Manufacturer and Gold Disk Number can be completed with related information if
desired.
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Adding a New Sequence

Edit Sequence

Sequence Mame: ITDF' Slot ITop j ¥ Component Sequence OK
Order Mumber |2 ™ Auto Store ASCII " Stop on Failed Component Cancel |
Compare Priority: ISame vl [ Show Instuctions ¥ Z Home Between Component
Previous |
Auta Stare Level: IEomponent.-"Net - ¥ Top Side ™ Awuto Store Passed
Sequence [0 |2 LI
r—Auto Stare File fedd New |
| Browse... |
Fepeat |
Irstructions | Top I Bottoml Top Imagel Bottom Image | Testers | Build |
Connect Common to PCE ground
Delete |
Delete Scanz |
Buttonz... |
Help |

To add a new Sequence, select the Sequence tab in the Tree pane. Select Add New
Sequence from the Edit menu or click the Add New button (+) in the toolbar.
Details:

Sequence Name Field: Enter Sequence name

Compare Priority: Selects the comparison priority between Same (serial humber),
All (serial numbers; this is the recommended setting) or Merge (Merged min/max
signatures)

Previous/Next buttons: Steps through existing Sequences backward or forward.
Instructions field: Enter any instructions or system information that you wish to
pass on to future users. Note: the ENTER key in this field will work as a carriage
return.

The Add New, Repeat and Build buttons will allow for another new Sequence to be
created saving the current one.

The Delete button will erase the selected Sequence.

Other functions within this window can be read about by clicking the HELP button.
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Information Note --

Component Package Types

Component Component

- , DIP Component SIP MULTT  poust jooms,
package ] package package ;| ¢ . <
[TTTTTITTT . ooboooson
1 10 —‘7 B stat tore T g T
Front Panel Connector Front Panel Connector Group 2 S g Group 3
@pns) | 5 o| epns)
16€———9 . 246810 J o o
nunuoccununnuuunn% T u\:\n\:\znuuuuuunuunn% MDDDDDDDDDDDN
0O DDODDODDDODDDODODODODDOODO o o Ooooo0ooODOD ED,DD“ 15 lB
1 ——»8 135679 HgﬁiiH
Component S Tracker with Scanner users
FRONT N eesosey BOTH will use DIP (including
[TTTITITIT  package @ package DIP2X), SIP (including
| ——»10 EeRAIRRROBE
T————»10 SIP2X), FRONT, BOTH,
GfonkEAnetGonnecior Front Panel Connector DIPII or SIPII
20 1 % [ —]
T— %10 s T————10

For Tracker with Scanner users, the package type determines how the Scanner pins
are counted. The available Scanner packages are DIP, SIP, Both, Front, SIPII
(combines the A and B channels for 128 pins) and DIPII (combines the A and B
channels for 128 pins). Users of the multiple Scanner II accessories can use the DIPII

and SIPII packages to daisy-chain Scanners together to achieve up to 1024 pins.
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Adding a New Component

Add New Component

Component Name: ]LH— Connection Type: m Pause 3 | oK
Order Number: [10— Open Check Type: W Ranges ThenPin v Lancel
Package: DIP +| Open Recheck Depth: m Short Check Type m |
Number Of Pins: 20 +| Converted Merges: l— Component 1D: |
Type: IMT Correction Steps m Sequence ID: ,2— 4‘
Pin Spacing ]100— &‘
Repeat
Part Package: I— TopX: [U— Build
Part Number: I— Top¥: ,U—
Part Tolerance: {— UpTopZ: [0—
Part Value: I— Bottom X: [D_ 4‘
Replacement: I— Bottom Y: [U—' —J
Supplier: [— Up Bottom Z: [U_
Instructions
Help

To add a new Component, select the Component tab in the Tree pane. Select Add
New Component from the Edit menu or click Add New button (+) in the toolbar.
Details:

Component Name field: Enter the component name (reference designator) in this
field.

Package and Number of Pins fields: Using the mouse, click on the down arrow to
the right of the field to bring up the pull-down menu. Select the package type and
number of pins from these menus.

Type field: This information is optional but you can enter the component type in this
field.

Connection Type: Select the type of hardware used to interface to the component.
Select Probes if manual probes will be used or Scanner if a Scanner II or Scanner
31S will be used.

Instructions field: Enter any instructions or component information that you wish to
pass on to future users.

Other functions within this window can be read about by clicking the HELP button.
Click the OK button to close the Edit window.
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Tree/Pin Tab

Once a component is added to the Workstation Tree, switching to the Pin tab will

display information for each pin of the selected component.

Tree - Board: Test Board

Sequences | Components m Component Scans

Mame | Pin Mumber | Order Mumber L | Met Mame | Scan Pin | Pause | Channel | Pulze Typ
4 v

2 2 2 W1 Icd - & +

3 3 3 358547 Ird - & +

4 4 4 ~Unused_Pins™ Icd I A +

5 5 5 358818 Ird - & +

E B E W2 Icd Il & +

7 7 7 W2 Icd - & +

g 8 g +30.5v Ird - & +

-
-

Text in the Name field can be modified directly by clicking in the text field and typing
the new name. The Scan Pin setting enables or disables scanning of the pin. Pause
will cause the scan to pause when the selected pin is reached.

Information on the other settings in the Pin tab is available in the Workstation Help.
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Adding a New Range

When a new component is added to a Sequence the ranges used are set by the
defaults set up in the Tools/Options/Ranges tab. On a new software installation

these defaults set three ranges - 3V, 50Kohms at 500Hz; 3V, 1IKohms at 200Hz

and 3V, 50 ohms at 60Hz. In general use, these three ranges will work well but you

may need to add or modify ranges based on component type and value. As a general

reference, the table below can be used to assist you in setting ranges.

Range

10Q2 - 100Q

1KQ - 10KQ

Impedancel

Voltage>
200mV

resistive
faults

20KQ resistive resistive
faults faults

100KQ resistive resistive
faults faults

6V 10V -15V 20V
newer MOS | power supply
ICs & regulators

resistive
faults

older MOS ICs

resistive faults | Hi resistance&

Hi power

The Tracker signatures are shaped based on the Tracker range settings. The basic goal

is to achieve signatures that are halfway between open and short. The signatures for

the four basic types of components shown below illustrate this primary goal.

Resistance

Capacitance

© Huntron, Inc 2014
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anerts Select the Tree/Range tab to display
ber |0Itage | Resistance | Frequency | Filter the ranges for the selected
component pin. RIGHT click on the
row header (far left grey area of the
row) to display a quick menu (shown
left)

Group Edit
et Edit
Delste
Disable all  »
Insert

Edit Range

Range Mumber: Bigbd] Delay Tester RangeID:  FinlD: il
[1 E Jo x| [Tracker RNEE [1232

Copy
Paste
Cut

3 naivew ranoe ISR

Cancel |

ik |

Yoltage: Resistance: Frequency; Max Samples  Tolerance Filter

B i AT | A G =l s 5| =

Camman Pin Prober Comman Pin Common Relay

" Current Pin 1[0 = 1o SRAD o
@ AlPins | T —

(" All Component/Nets

Help

" All Sequences

To add a new Range, select the Range tab in the Tree pane. Select Add New Range
from the Edit menu or click the Add New button (+4) in the toolbar. A pop-up dialog will
ask where you want the new range to be added. Select the desired radio button (All
Pins is generally the desired selection) and click OK.

Add New Range Details:

Note: Voltage/Resistance/Frequency can be modified directly in the Range grid.
Voltage/Resistance/Frequency fields: Select the desired range settings

Max Samples/Tolerance/Delay: Select the setting to be used when scanning this
range

Common Pin: Select Scanner common pins to be used when scanning this range.
Scanner users wishing to use a particular component pin (i.e. ground pin) for Common
should select the Common pin at this time using the Common Pin 1 field (the

Common Pin 2 field is rarely used).

Note: It is easier to set up the ranges used by selecting Tools/Options/Range from

the Tools menu in the menu bar and pre-configuring the default ranges.
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Scanning with a Tracker or Tracker with Scanner

To scan an entire Sequence, select the Sequence in the Tree/Sequence tab or enable
the Sequence checkbox in the Scan tab. To scan an individual component, select the
component in the Tree/Component tab.

Select the Scan tab in the Signatures pane and input a Serial Number then click the
Start button.

Signature — Tracker: Tracker 30 Scanner: None
Signatures Scan ]Tmubi&sheei] Tracker[ Scanner | Preview]

Serial Number Operator
1234
Time T
Start  |11:09:43 Est [00:01:21
Elapsed [D0:00:06 Left: [00:01:14 /
Component/Net — /
] o [6 Pass:[q
r r F | | 5] | | )
I Sequence r
Stimulus: Select
Stop <lf

You will be prompted to connect to the component. Tracker with Scanner users should

connect to the selected component at this time. Click OK to initiate the Scan.

Connect to Component '

Flease connect ta Component U1,

Click OK button to start the scan, or click Cancel button to cancel
the scan. A sequence scan can be stopped by clicking Stop
button and resumed later by clicking the Continue button.

Instructions

Stop | Cancel |

Erevious Pin

[Stoos the scan allowina it to £

If you are performing Sequence scan you will be prompted to continue to the next

component until all of the components in the Sequence have been scanned.
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If a Tracker with probes is being used your will prompted to connect to pin 1 of the
selected component (if performing a single component scan) or of the first component
in the Sequence (if performing a Sequence scan). Click the OK button to scan the first
pin. You will then be prompted to move to the next pin for scanning. Click OK to scan
and continue in this manner until all of the component pins are scanned. At anytime
during scanning you can click the Previous Pin button to go back and rescan the
previous pin.

Connect to Component i

Please connect the red probe to Component C1, Pin 2.

Click OK button to start the scan, or click Cancel button to cancel
the scan. A sequence scan can be stopped by clicking Stop
button and resumed later by clicking Continue button.

Instructions

Previous Pin | Stop Cancel

Once all pins are scanned click the OK button to continue.

When the Sequence or Component scan is complete the Scan Results window will be
displayed. Go to the Scan Results section of this tutorial for more information on
what to do after scanning.

If an Scanner is being used you will be prompted to Connect to the Component before
the scan is executed. Connect the Scanner cable to the component to test and click

Okay to start the scan. Once the scan is complete, the Scan results will be displayed.
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Scan Results

Signature — Tracker: Tracker 30 Scanner: None

Signatures  Scan ITroubl&sheet] Tracker] Scannerl Preview]

Serial Number Operator
l FAILED

]suspect 1
i~ Time
Start |14:32:29 Est: 100102:48
Elapsed ]DD:D3:31 Left: ]-00:00:4
- Coﬁxponenb’Net =
|22 of | Pass:h

[~ Stop On Failure I~ Scan Continuous

I Sequence [ Use Scan List
Stimulus: |=:S-‘:Ir;w:1r: __]

Start l Troublesheet ]

When a scan is complete, the results PASSED, FAILED or NO REF will be displayed (the
text of the PASSED or FAILED message can be changed in the
Tools/Options/General settings). The NO REF message will be displayed on the first

scan of any test since there are no signatures stored as Reference.

Clicking the Troublesheet button will display the signature differences in the

Troublesheet tab of the Signature pane.

Note: Selecting the Troublesheet tab will display Troublesheet information from the

previous scan.
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Viewing Signatures - Troublesheet

Signature — Tracker: Tracker 30 Scanner: None
Signatures | Scan Troublesheet ]Tracker] Scanner ] Preview]

Failed | Removed | Passed| No Ref | ' = - i|
Summary A/ (_/yl
e [ -t b
Store
Delete / [——‘b
Copy
Update f) [—j /,_ﬁ
Scan List e e — vy saaey
rs“cz;'e(- 263C4C5 ,A/J__“ sxgpnac (J_ (__j 5
Set Reference | Mergel Al [

To view the Troublesheet, press the Troublesheet button in the Scan Results
window. This will display the signatures that compare differently from the Reference
signatures.

When a scan is executed signatures are compared against the Reference set (or sets)
if it exists. On the first scan, the signatures will be displayed in red in the No Ref tab.
This occurs because the first scan has no reference to compare against. To add the
signatures in the Troublesheet as a Reference, press the Set Reference button (do
this only with known good signatures). Signatures of the compared signatures are
displayed in contrasting colors. By default, the Reference signature is green and the
failed signature is red.

Use the vertical scroll bar to scroll through the scanned pins. Use the horizontal
scroll bar to scroll the pin ranges especially if the viewing is set to Pin mode (see
Viewing Signatures — Right Click section).

To add the Troublesheet signatures to the Merge signature set, press the Merge
button (do this only with known good signatures that vary slightly from the original

Merge signature set).
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Viewing Signatures Troublesheet Report

Troublesheet Report =10| x|
Top Level
ISequence 3
Detail Level
IComponent/N et LI
Problem
ILow 5V
Solution
|replaced C11
Preview I Close I
RI=EY
B File = View Background v|
D page st B & o (& EETIFEEa
&? print...
&) Print
L[;) Export Document... » | «/ PDF File
~1 Send via E-Mail... » HTML File
@ ex MHT File
RTF Fils Troublesheet Report =
G 6/3/2008 1:25:27 PM
Excel File
Serial # :
Dperator, CSV File
Results: Text File
Problent Image File
Solution: | o
Board Information
Name: 89006330 Reviston: |4l Lindt: |
Top Name:  |Top Gold Disk: | [
Bottom Name: (Bottom Systen:
Instructions:
P Tnformati
4 i
Nawme: |Top |ID: ll |0rdar Number: Il
Z Home Between Componenis ITrue |S‘lop on Failed Componag: lFalse lTop Side: lTrue
Component Secuence: |T1ue |Compare Priorily: |A11 |Sﬁow Instructions: |False
Instructions: |
Total Component/Neis: ]55 |Tota1 Scanned: |54
Total Passed:[54 [Total Faited: 0 [TotalRemoved: [0
<] [0
Current Page: 1 Total Pages: 1 Zoom Factor: 100% |

To view and print the Troublesheet report, press the Print button in the Troublesheet
window. You can select from several options including a Sequence or Component Level
report, the level of detail and add problem and solution comments to the report. Click
Preview to view the report on-screen. The report can be printed or exported in
several different formats including HTML and PDF by selecting File/Export Document

in the Preview window.
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Viewing Signatures in the Signhatures Pane

Signature — Tracker: ProTrack Scanner: ProTrack Scanner B x|
w Troublesheet | Tracker | Scanner | Preview
Scan List [Py P2 Ph:3 Ph:t -
Y T T T i
005 8:13:53 AM
L I B | 1 11 4 ol I/—jl 4 LN ] [D—O—O—O—O—l [ 20N | l/v—jl 14
4 L 4
3v 100 20Hz 3v 10 20Kz 3v 10 20Kz 3v 10 20Kz
[Pi:s 3 Pt P8
T ¥ T
L | (—0—0—6—‘—1 G Hl 14 L I f—‘—‘—H—( [ B I ] e 4
4 4 i
3v 10 20Kz 3v 100 20Kz 3 100 20Kz 3v 10 20Kz
[Fi-s Ph: 10 e 1 P 12 e
T T %
L | I/JI 4 | A T S | LI B A | L I r—‘ﬂl 14 2 P | fl—.—i—-O—Q—C
4 i i
3v 10 20Kz 3v 100 20Kz 3v 100 20Kz 3¢ 100 20Kz
fﬁ. 13 Phti Ph:1S Ph:16
T T
L N B | | O T ! k11 H L | L I B | | B L2 B | Vﬂ L I |
———————————————————— 4 &
Scale 3v 10 20Kz 3v 10 2Kz 3v 100 20Kz 3v 100 20Kz :l
C1C2C3GF&C 5
% < I l L‘
Copy | Print |

To view scanned signatures, select the Signatures tab in the Signature Pane. The
Scan name, date and time will be displayed on the left side of the window and
signatures on the right. The Scale buttons will change the number of columns
displayed. Scaling the window will increase the number of signatures displayed. The
Copy button will copy the signhatures to the Windows clipboard so they can be pasted
into another program (in a metafile format). The Print button will print the signatures

in one of several different user selected formats.
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Viewing Signatures - Right Click

Signature — Tracker: Tracker 30 Scanner: None
Slgnamresl Scan  Troublesheet |Tracker] Scannerl Preview
Failed | Removed | Passed| No Ref | == i{
Reprobe Pin Signatures
123 | None:
4‘ [ Real Time
_-S-"m] 1 » Get Signature
Remove | |~ Get Pin Signatures ]
Store Replace Signature
Delete Replace Pin Signatures
Print A e lapeest Sync Pin/Range —
Copy Edit Range
Disable Range
Update
z Edit Pin
Scan List = a2 Edit Comp/Net -
Group Edit
Net Edit
..... e imans iy SigAssist —_—
Sync CAD
H Sync Image
i, i i Copy lj
Scale ‘ Data _TL]
CHe2630405 Pin Mode
Set Reference | Merge l

Additional options when viewing signatures can be displayed by right clicking in the
sighature area.

Reprobe Pin Signatures: Capture signatures for all displayed ranges and prompts to
replace signatures immediately — available in Range mode only

Real Time: Display signature in real time

Get Signature: Capture signature for selected pin and range

Get Pin Signatures: Captures signature for all ranges — works only in Range Mode
Replace Signature: Replaces the current signature with the captured signature
displayed for the selected pin, range and scan (shown in the Scan List to the left)
Replace Pin Signatures: Replaces the current signatures with the captured
signatures displayed for the selected pin, all ranges and scan — works only in Range
Mode

Sync Pin/Range: Selects pin and range in the Tree (see default in Tools/Options)
Edit Range: Selects the pin and range in the Tree and opens the Edit Range dialog
Disable Range: Disables the selected range (set in the Tree pane, Ranges tab)
Edit Pin: Selects the Pin the in the Tree and opens the Edit Pin dialog

Edit Comp/Net: Shortcut to the selected Component Edit dialog in the Tree pane
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Group Edit: Opens Group Edit dialog for editing of component pin parameters as a
group

Net Edit: Opens Net Edit dialog for editing of Net pin parameters as a group
SigAssist: Displays the SigAssist window showing calculated approximate values of
resistance, capacitance, breakdown voltage, etc. based on signature information
Sync CAD: Will link the selected signature to the CAD image displayed in the
Image/CAD pane. Sync CAD will be disabled if there is no linked CAD data.

Sync Image: Links current Troublesheet to the image in the Image pane/Image tab
Copy: Places the signature image in the clipboard

Data: Displays the signatures numeric data

Range/Pin Mode: Displays signatures with Range priority or Pin priority - see default

in Tools menu/Options/Signature tab)

View SigAssist Information
Sigassist(TM)

Pin: 2 Deviation: 35 H/W Deviation: 0

Range: 3V 10K 200Hz Area: 1431 H/W Area: 0

Tolerance: §

Serial # Scan Res. Cap. Power Fbd Rbd MaxV MaxI ;]
Hardware 11/3/2005 2:38:24 PH 0.000 0.000pF 0.000nW ov ov 0.202V 200.000na
001 11/3/2005 2:03:01 PM 0.000 0.000pF 270.000uW 1.29v ov 2.100V 126.000ui
001 11/3/2005 2:01:10 PM 0.000 0.000pF 450.000uW 1.11v ov 1.260V 246.000ud

Copy |

The SigAssist window can be viewed by right-clicking on a displayed signature and
selecting SigAssist. It appears as an additional pop-up window. The information
presented relates to the individual scans displayed in the signature. The calculated
resistance, capacitance, power, forward breakdown voltage (Fbd), reverse breakdown
voltage (Rbd), maximum voltage and maximum current are displayed. These values
are for troubleshooting purposes only and are not intended to be used as true
measurements. The accuracy of the SigAssist values depends greatly on the scanned
signature information. SigAssist values may not be calculated for signatures that do
not contain enough information for reasonable calculations to take place (i.e. opens,
shorts). The Copy button will put a copy of the window into the clipboard for use in

other programs.
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Component Scans Information

Tree - Board: Test Board

Serial Mumber | Operator | Scan Date Time i | Merged | Fieference | Pazzed
Thurzday, February E4:14:21 PM

Thursday, February 02, 2006 4:18:35 P

Selecting the Component Scans tab in the Tree Pane will display all of the scans
performed on the selected component in a table format. The Scan information
displayed includes the serial nhumber, operator, date/time, Merge setting (checked if
this scan is included in the Merge set), Reference setting (checked indicates it is set as
a comparison Reference), Pass status (will be checked if components passed
comparison), Removed status (will be checked if component was removed from
Troublesheet), Area number (highest of scanned pins), Deviation, Min/Max status and

other settings (see Help for more information).
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Component Scans - Right Clicking (Auxiliary menus)

Tree - Board: Test Board

Serial Humber | DOperator | Scan Date Time & | b erged | Reference | FPazsed

Enable Sequence Reference

Disable Sequence Reference hursday, February 02, 2006 4:18:35 P

Delete Scan
Delete Scan All Components/Mets

Load Troublesheet

Right clicking on the Row bar of the Component Scans tab displays an additional menu
for performing specific tasks such as enabling/disabling References, deleting a scan for
the selected components or all components and loading a Troublesheet. Enable
Sequence Reference will mark the scan as a Reference for the entire Sequence.
Disable Sequence Scan will disable the selected Sequence as a reference. Delete
Scan will erase the selected scan for the current component only. Delete Scan All
Components/Nets will erase the selected scan for all components or nets in the
Sequence.

Load Troublesheet will display the selected scan in the Signatures/Troublesheet

pane.
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Component Scans - Right Clicking (Auxiliary menus)

Tree - Board: Test Board

| Mindh

Set All Scans ko Current Reference Component/Met

ary 02, 2008 4:14:21 P r Delete all Scans to Current Reference  # Sequence |

g _m | |
Sork Ascending

Sork Descending

Right clicking on the Column bar of the Component Scans pane displays an additional
menu for performing specific tasks such as sorting or globally setting parameters. The
menu will vary depending on the column selected. In the image above, the Reference
column header was right-clicked.

This method is the easiest way to delete non-reference scans that are listed in the
Tree/Component Scans pane. Select a scan that is a non-reference (the Reference
check box is unchecked) the right-click the column as shown above. Select Delete All
Scans to Current Reference/Component/Net or Sequence to delete the non-

reference scans for the individual Component/Net or for the entire Sequence.
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Component Scans - Right Clicking (Auxiliary menus)

Tree - Board: P/N: S008656 Revision: B4

‘Seauences | Components| Fins | Ranges |Component Scans |
Seria] Mumb [Onerator | Scan Nate Time ; . |Stimulus  |Merged | Reference | Passed
260-0  Set Serial Number Same Date/Time Scans 322 AM None r v 3
suspe Sort Ascending :39:20 PM None I [ r
Susps Sort Descending :56:45 PM None ' ] r
suspect] :34:30 PM None O [ r
» pa Thursday, October 30, 2014 2:32:29 PM

Right clicking on the Column bar of the Scans pane displays an additional menu for
performing specific tasks such as sorting or globally deleting items. In the image

above, the Serial Number column header was right-clicked.
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Sequence/Component/Pin Editing — Right Click menus

Tree - Board: Test Board
Components |SFIRE
Hame | Order Humber ¢ | Package | MHumber OF Ping | Type | Replacement | Supplier | Part Mumb
| Add Mew
MU
| Delste MULTI 1
o [neert MULTI 1
[ B MULTI 1
| Buid
MULTI 1
— Copy
| paste MULTI 1
cut MULTI 1
Delete Scans MULTI 1
4 3
j Sync CAD _I —I

Right clicking on the Row header bar of the Tree pane displays an additional menu for
performing specific tasks such as Add New, Insert, Delete, Repeat, Build (repeat
but with name incremented by 1), Copy, Paste and Cut. Right clicking works at all
levels of the Tree pane including Sequence, Component (shown above), Pins, Ranges
and Scans.

It is also possible to select groups of components by holding the SHIFT or CTRL keys
while selecting components in the Tree. To copy, paste, cut or delete groups of

components, use the Copy, Paste, Cut or Delete Toolbar buttons below the main

menu.
ﬂ Huntron Workstation {Developer) z:Huntron',Boards', Test Board.
. . File Edit Wiew Actions Tools ‘window Help
Pin Editing -y ) i [T K X+ # i dhde 2 e b oi
Rig ht | Tree - Board: Test Board
Component: |SFiRE | Ranges | Campanent Scan:
CIiCking Mame | Order Number 2 | FPackage | MHumber OF Ping | T

(Auxiliary N N
menus) N (R
O (R

o

ES E MULTI 1
TM 7 MULTI 1
TFP2 g MULTI 1
TP2 9 MULTI 1
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Tree - Board: Test Board
ge: | Component Scans
| Fir Mumber = | Order Murmber | Met Mame | Scan Pin | Unique Pin | Channel | P~
»
- : v n
| Group Edit I r *
Met Edit 3 3 01 + r & N
| synecap [* 4 W5 v il A +
5 5 5 D2 rd r A +
B B g “Unuzed_Fing™ [ [ 1) +
7 7 7 D3 Ird r A +
8 a a “Unuzed_Fins™ [ [ A +
9 9 | D4 ¥ - A + oL
< I _>I_I

Right clicking on the Row header bar of the Tree/Pins pane allows for editing of the pin
information. Select Edit to open the Edit window for the selected pin.

Note: Some Pin settings can also be edited directly in the Pins grid by clicking the
appropriate field and modifying the setting.

Group Edit and Net Edit allow you make changes to the pin of a component and have
those modifications also change components that have the same number of pins within

the same Sequence.

ﬂgﬁroup Edit {Component)

=10l x]

Componert: I-‘M:H

Components:

—

Pins:

mﬂmmllw I\JI

Update
Pinz/Ranges

Pir: |1 11 Met | "Unused_Fine™

—Pin Settings
" Channel
" Corection Steps
™ Pulse
" Relay Mumber
™ Scan Pin

™ Unique Fin

Llaze

[ Ranges

Help

Change the desired settings for the
current Pin first then select Group
Edit from the right-click menu (see
above). Components with the same
number of pins will be listed. Select
the components and pins you want to
be changed. Select the Pin Settings
check box(s) for the setting(s) you
want changed. Check the Ranges box
to match the ranges (this will cause
signatures to be deleted). Click the
Update Pins/Ranges button to
make the changes.
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Pin Editing
Pin Name: |1 Channel: IA vl Relay Number: IU

Pin Number: |1 Order Number: |1 Cancel
Net Name: I Unique Pin: Pin ID: |2|]5

Correction Steps |3 ScanPin [V Component ID: |5

Previous

Next

tlEE

Probe Pulsel Shorts I

Pulse: Off v

Pulse Type: |+ VI
Pulse Level: IU vl

Duty Cycle: |50 v

Instructions

Help J,
%

Individual pin characteristics can be edited in the Pin Edit window. Net name,
Channel, Correction steps (for Access Probers) and Scan Pin (enable/disable

scanning of the pin) can be controlled.
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Huntron Workstation Buttons Feature

Huntron Workstation has a built-in feature that allows any Windows based program to
be started by clicking a button in the Workstation toolbar. It is very easy to use and a
“Button” can be attached to any Board, Sequence or Component/Net. In this example,
a Button will be created for a Sequence but the process is the same for the Board and
Component/Net levels.

To start, the Sequence edit window is opened by right-clicking the row header for the

desired sequence. The Edit window will be displayed (see below).

Sequence Name: |Liil§ Slot ITop :] ¥ Component Sequence 0K
Order Number |2 I~ Auto Store ASCII ™ Stop on Failed Component e |
| Order Number Compare Priority: IS T vI I” Show Instructions IV Z Home Between Component -
BOTTOM 1 . _ P |
Auto Store Level: IComponenv’N et 'I IV Top Side I” Auto Store Passed
Nest I
dd New Sequence ID |3
—&uto Store File addNew
Delete | Browse... |
Bepeat |

Insert

Top | Bottom| Bud |
Ahgn Image Top 1 Allgn Image Top 2 =

Align Top1X |2454,33 7 il 4 Delete |

AlignTop 1Y |1456.12 (7% Delete Scans I

Buttons... |

Repeat
Build

Copy
Paste

Cut

Align Top 2 [53'311'31_
AlignTop2¥Y [WT |
UpTopZ W
Down TopZ FW [

Delete Scans

Instructions

Align 1 =YIA_16. Align2=VIA_5. TopSide Slot: Top  Board Spacers: NoWalls  Optomize Method: None
Connect Common to TP3.

Help

Select the Buttons... button located on the right side of the Sequence Edit window to

open the Buttons Setup window.
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Button Setup

Order Number |1 Button Level ISequence
Enabled v Parent ID |3

Caption I Button 1D |

Command Line I Browse...

File Path I Browse...

[y

Icon File Path I Browse...

— Tooltip
—Store File in Database ———— Store Icon in Database

§ | Store File [Load File,.. I { I Store lcon Load File... I
Brevious | | Hew | | AddNew | ok | cCancel | Hep |

To configure the Button, a Caption (button name displayed in the Tools menu),
Command Line (the application to be run) and File Path (the file opened by the
executed application) need to be input into the corresponding fields. A File path will
not always be required such as instances where a browser is started and pointed to a
specific URL. In this example, the button will be configured to start the Microsoft Paint
application and open a small PCB image (see image below). If desired, the icon
displayed in the main window toolbar can be set by browsing to and setting a path to
an .ICO (icon) file in the Icon File Path field. Add text that will be displayed when the
cursor is placed over the Button in Tooltip field. To make the linked file or icon stored

as part of the Board database, check the Store File and/or Store Icon checkboxes.

© Huntron, Inc 2014 21-2260 Rev C 31



Button Setup R 7

Order Number |1 Button Level |Sequence
Enabled v Parent 1D |3
Caption lBoard Image] Button 1D |1

Command Line lC:'\WlNDDWS\system32\mspaint.exe Browse...

File Path lz:'\H untron‘Boards\board-images\board-imag Browse...

Icon File Path l Browse...

[y

— Tooltip
Displays image of PCB top side

—Store File in Database ———— Store |con in Database
I~ Store File Laad File... I I' I Store lcon Laad File... I
Previous | ewt I Add New I OK I Cancel I Help l

Click OK to accept the Button. To create additional Buttons, repeat this process and
click the Add New button in the Button Setup window.

When Buttons are created, an additional toolbar will appear below the Huntron
Workstation menu. This toolbar will change according to the level (board, sequence or

component/net) selected.

indow Help

Sl A B & ko EE—

The icon shown can be replaced by selecting an appropriate icon in the Button Setup

window (the default icon is shown). Click the toolbar button to execute the Button.
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Technical Support

For questions or assistance in using Huntron Workstation, contact Huntron at
800-426-9265, 425-743-3171 or email info@huntron.com.

There is online assistance for Huntron Workstation at

www.huntron.com/support/workstation.htm. This page will contains software updates,

a form for reporting software issues and updates to documentation such as this
tutorial.
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